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 Features and Functionality 

This document describes how the application runs to calculate and draw in CAD 

tunnel Cross-Sections taken from digital total stations. This program is complementary 

to the data gathering and setting out application TcpTunnel for Windows CE, although 

files generated by other applications available in the market can also be used. 

 

The application allows one to define a project made up of the ground plan and 

elevation alignment, optional superelevations and the theoretical cross-section whose 

parameters are specified. Such data may also be optionally copied to the mobile device 

for its use with the above-mentioned program. 

 

Once the coordinate data of the points corresponding to the total station’s survey 

are available, it is possible to draw the cross-sections obtained with different options, 

render the theoretical and measured tunnel with a 3D wire diagram, in addition to 

obtaining point and volume lists. 

  

 Command Reference 

 Create Project 

In order to avoid having to remember each of the files making up a project, a type of 

file to store the links to each of its essential components has been created. 

 

All these components should be kept in the same folder where the project is to be 

created. 

 

Once the name of the project to be created is entered, a screen is shown where the 

files making up the project should be selected: 

 

 

 



TcpTunnel CAD                                                                                                             Reference Manual 

 

Aplitop S.L. 6 

 

 

 

The Points, Control Points, Horizontal Alignment, etc. buttons allow one to select 

each of the components making up the project. Of all of these, stations and 

superelevations are not obligatory. 

 

 Within Template Orientation, it must be selected if the profiles are created 

vertical or perpendicular to horizontal alignment. The lastest option should be used for 

tunnel with high slopes.  

Vertical 

 

 

 

Perpendicular to vertical alignment 
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 Pressing the Edit... buttons open an editor to create or modify the selected item. 

With the OK button creates the project indicated containing the files selected. 

 

The different kinds of files requested are described below. 

 

 Points 

The surveying points of the current project are stored in these files in ASCII format. 

These files have the *.PUN extension (compatible with MDT) and contain the 

following data for each point separated by spaces: 

 

<Number> <X Coordinate> <Y Coordinate> <Z Coordinate> <Code> 

 

Name Type Length No of Decimals Remarks 

N Alphanumeric 14 0 Point number 

X Numeric 11 3  

Y Numeric 11 3  

Z Numeric 8 3  

Code Alphanumeric 14 -  

  

Files in GSI format may be selected directly. The application will automatically 

import such files and create the corresponding *.PUN file. 

 Stations 

The surveying stations of the current project are stored in these files in ASCII 

format. These files have the *.BSE extension (compatible with MDT) and contain the 

following data for each station separated by spaces: 
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<Number> <X Coordinate> <Y Coordinate> <Z Coordinate> <Anamorphosis>  <Code> 

 

Name Type Length No of Decimals Remarks 
Station Alphanumeric 8 - Station's name 

X Numeric 11 3  

Y Numeric 11 3  

Z Numeric 8 3  

Code Alphanumeric 14 -  

Scala Numeric 9 8  

 

 Horizontal Alignments 

These files are also compatible with the file format of TCP-Digital Terrain Model 

(*.EJE) files. 

 

The records have the following fields: 

 

Name Type Length No of  Decimals Remarks 
Station Numeric 11 3 Kilometre point 

X Numeric 11 3  

Y Numeric 11 3  

Azimut Numeric 8 4  

Parameter Numeric 9 3 Clothoid section parameter 

Radio Numeric 9 3  

 

 Vertical Alignments 

These files are compatible with TCP-Digital Terrain Model (*.RAS) files. 

 

The records have the following fields: 

 

Name Type Lenght No of º Decimals Remarks 
Station Numeric 11 3 Kilometre point 

Height Numeric 8 3 Vertex height 

Kv / Radio Numeric 9 3  

Tangent Numeric 9 3  

Arrow Numeric 9 3  

 

 Superelevations 

These files are compatible with TCP-Digital Terrain Model (*.PER) files. 
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The records have the following fields: 

 

 

Name Type Length No of Decimals Remaks 
Station Numeric 11 3 Kilometer point 

Pl Numeric 6 3 Left hand superelevation 

Pr Numeric 6 3 Right hand superelevation 

 

If the value of the right-hand and left-hand side superelevations is “B”, it indicates 

that there is pumping. In other words the value of both superelevations is –2.0%. 

 Tunnel Templates 

This kind of file stores information on the tunnel template or tunnel templates along 

the project’s alignment (See Edit Tunnel Templates command). 

 

The extension of this kind of files is TNL. 

 Cross-Sections 

This kind of file stores the information about measured profiles. It is created 

from horizontal and vertical alignments, tunnel template and measured points. 

 

The records have the following fields: 

 

Name Type Len

ght 

No of  Decimals Remarks 

Station Numeric 11 3 Kilometer point 

Offset Numeric 8 3 Point's offsert relative to alignment 

Height Numeric 8 3 Point's height 

Number Alphanumeric 16  Number of  the measured  point 

 

The extension of this kind of files is TRI. 
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 Open Project 

 With this command one can change the current project. All the other commands 

will use the last project loaded.  If one has not been opened, it will ask for a created 

project. 

 If one uses the option of creating a new drawing in CAD, it will forget the last 

project loaded, and any other subsequent command will ask for a project. 

 

 Edit Project 

This command enables one to change the files to be used in an existing project. 

 

 

 

The changes made to the project selected will be stored by clicking on the OK 

button. 

 

 Edit Tunnel Templates 

This command allows the cross-section file (*.TNL) that will be used along the 

length of the project’s alignment to be created. 

It shows up a dialog with the created cross-sections. 
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New: This option creates a new template, which must be drawn before it can be 

assigned graphically. 

Edit: This allows one to edit an existing template. 

Delete: Deletes selected tunnel template. 

 

Any new templates that have been created or deleted will only be saved if one exits 

the dialog by using the OK button. 

 

 New Tunnel Template 

The tunnel template is defined from a polyline. The polyline may be open or closed, 

and may be generated either clockwise or counter-clockwise. Once selected (you are 

asked to Select Tunnel Template) the following data is requested: 
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Name: Name of the cross-section. S1 is shown by default. If more than one cross-

section is created, they will be named S2, S3, etc. 

 

Horizontal distance form H.a. to Center: A positive value indicates that the ground 

plan alignment is to the right of the cross-section’s center and a negative value 

indicates it is to the left. Differently to the grade line and superelevation application 

point, the ground plan application point can be defined to be outside the tunnel 

template. 

 

Vertical distance from Keystone to V.a.: A positive value should be indicated if the 

keystone point is above the grade line and superelevation application point and 

negative otherwise. Under normal conditions, this value should always be positive. 

The grade line and superelevation application point should be within the tunnel 

template. 

 

Horizontal distance from V.a. to H.a.: In this case the reference is the ground plan 

alignment’s application point. One will therefore have to indicate a positive value if 

the vertical alignment and superelevation application point is to the right of the 

alignment and a negative value if it is to the left. 

 

Advanced (Superelevations): If a superelevation file has been selected, the program 

allows tilt the tunnel template depend on the superelevation values. If Keep tunnel 

template fixed is selected and the tunnel template is open, the superelevations will 

be applied, creating the roadbed and closing the tunnel template. 

Keep tunnel template fixed                  Tilt tunnel template 
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 Edit Tunnel Template 

This command allows one to change the parameters of an existing tunnel 

template. First, one must indicate a insertion point inside the drawing. Then the Edit 

Tunnel Template dialog is displayed (see New Tunnel Template). 

 

 Tunnel Template Assignments 

After the tunnel templates have been defined, they must be assigned to the 

different sections.  

To create assignments, select one of the created Cross-Sections listed in the 

Tunnel Templates box and specify the different parameters. 

 

 

 

Final station: Station until which the selected template is applied. 

Use the following buttons to change the assignments. 

Insert : Insert a new assignment with the control values. 

Edit: Opens a dialog for editing the values of the selected assignment. 

Delete: Delete the selected assignment. 
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Delete All: Delete all the assignments. 

 

The application will interpolate the templates between each assignment, if 

possible it will be indicated into the table.  If no interpolation is required, a copy of the 

previous assignment must be created. 

 

Exit the dialog with the OK button to save any changes made 

 Calculate Cross-Sections 

This option calculates the cross-sections with the project points, for which an 

alignment is required.  The cross-sections calculated are saved in the project cross-

sections file, using the format *.TRI. 

 

 

Initial station: Station from which measured points to be drawn are sought. The 

project’s alignment is indicated next to the initial station. 

 

Final station: Station up to which measured points to be drawn are sought. The 

project’s alignment is indicated next to the final station. 
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Station interval: Value by which stations increase from the initial station indicated 

up to the final station. 

 

Station tolerance: Station’s regression value. If the difference between a station 

analyzed for a point and a station on the theoretical list is less than this value, a 

point in the theoretical station profile is considered to which it is adjusted. 

 

Minimum points distance: Minimum distance between two consecutive points of 

the profile. 

 

Minimum points: Minimum number of points that a profile must contain. 

 

Close cross-sections: After calculating each cross-sections, the program will join the 

final and the initial point to create a closed cross-section.  If the cross-section is 

open, the join between the ends will not be taken into account when calculating the 

surfaces.  If there is a closed theoretical cross-section, this option must be marked if 

one wants the surface area calculation to include the whole cross-section. 

 

Include non-multiple stations: Initially, the file’s points are analyzed and grouped 

together by the closest station according to the tolerance indicated. These stations 

are then adjusted in accordance with the tolerance to the stations appearing on the 

list created according to the Station interval. By marking this box, one indicates that 

one wishes to take into account stations that have not been adjusted to any multiple 

of the initial station indicated in accordance with the Station interval. 

 

Adjust to theoretical station: Uses the stations calculated with the interval and the 

initial and final stations instead of the stations calculated automatically. 

 

Round stations: Round cross-section stations to the closest integer. 

 

Cross-sections Center: This option allows one to set up the point which is used to 

sort the points of the profiles. If Auto option is selected, the point calculated is the 
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center of the rectangle that encloses the profile points. Otherwise, horizontal and 

vertical alignments application points will be use. The program allows one to 

change those points entering a horizontal and vertical distance. 

 

Cross-Sections File: Cross-Sections file output, by default it will show cross-

sections file project. 

 Draw Cross-Sections 

Graphically shows the differences between the tunnel cross-sections gathered in the 

field and the tunnel templates. 

 

To start off with, the following data is requested: 

 

Initial station: Station from which measured points to be drawn are sought. The 

project’s alignment is indicated next to the initial station. 

 

Final station: Station up to which measured points to be drawn are sought. The 

project’s alignment is indicated next to the final station. 

 

Minimum Height: Height with respect to the grade line for cutting the cross-

sections and theoretical cross-section, by a horizontal line.   
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The elements one wishes to show can be selected in the Drawing section, as can the 

Scale, Text Height, Space (Model or Paper) and Drawing Format.  The latter has 

options for drawing Cross-Sections in Continuous mode or on several sheets of DIN-

A0, DIN-A1, DIN-A2, DIN-A3 o DIN-A4 paper. The option of also drawing one profile 

per sheet (DIN-A4) is also offered in the Individual option. 

The drawing option in paper model allows one to use the CAD command “Publish” 

to print the cross-sections in PDF. 

  

The elements making up the drawing include: 

 

Point Number: Number of the points taken in the field. 

 

Point Height: Height of the points taken in the field. 

 

Difference: Perpendicular distance to the tunnel cross-section from the point 

measured. 

 

Dimensioning Lines: Lines that join the point taken and its projection on the 

tunnel’s theoretical cross-section. 

 

Station: Theoretical station calculated by regression. 

 

Vertical Alignment Height: Vertical alignment height at the theoretical station. 

 

Superelevation: Left-hand superelevation at the theoretical station. 

 

Horizontal Alignment Coordinates: X and Y coordinates of the ground plan 

alignment at the theoretical station. 

 

Area: Undercut and overcut areas and total areas of the theoretical and measured 

cross-sections at the theoretical station. 
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Grid: Is only activated when the Individual option is selected in Drawing Format. 

Shows a grid to mark distances and heights. 

 

You are requested to select an insertion point for the drawing when OK is clicked. It 

should be taken into account that theoretical Cross-Sections are only drawn when 

measured points have been found depending on the filters indicated.  It could therefore 

happen that no drawing is generated. 

 

 

 

Theoretical and measured cross-section drawing (Individual) 
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Theoretical and measured cross-section drawing (DIN-A3) 

 

 

 Edit Cross-Sections 

This tool allows one to edit the cross-sections created previously for deleting, 

mainly, the points which introduce noise in the profile, by example, the points 

surveyed on ventilation pipes. Read Cross-sections Editor for more details. 
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 Import Cross-Sections 

This command allows user to import a cross-section file with TRA extension, 

used in previous versions of TcpTunnel CAD.  

After selecting the file to import, the program will create a file with the same 

name and TRI extension, it will be included in the current project and it will be showed 

in the cross-section editor. 

 Draw Tunnel 

Shows a 3D graphic of the theoretical and measured tunnel. In both cases the initial 

and final stations delimiting drawing request. If no cross-section file exits in the project, 

or it’s empty, the corresponding section will appear disabled. 
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 Drawing elements can be selected independently for measured and theoretical 

tunnel. The points and the cross-section can be drawn in both cases, and longitudinal 

lines in the case of the theoretical tunnel. The distance between theoretical points can be 

entered in the Discretization distance box. 
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 Areas and Volumes Report 

 There follows a description of the common part of the areas and volumes lists. 

Using any of two options will show a common dialog for the parameters. Both reports 

have the same input parameters. 

   

 

Initial station: Station where volume calculation starts. The project’s alignment is 

indicated next to the initial station. 
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Final station: Station where calculation ends. The project’s alignment is indicated 

next to the final station. 

 

Minimum height: Height with respect to the grade line for cutting the cross-sections 

and theoretical cross-section, by a horizontal line.   

 

Once the data requested has been entered, the following list is shown after clicking 

on OK. 

 

 Areas Report 

If the areas report has been selected, the report displayed will be as follows. 

 

Station: Shows the stations where points have been observed. 

 

Perimeter.: Cross-section perimeter. 

 

Area.: Area formed by the cross-section of the previous and next station on the list.  

This is calculated by the Mean Areas method: 

A = ( PerimeterFST + PerimeterIST ) * ( ( FST – IST ) / 2 )   
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where   

 FST = Final Station of the interval. 

 IST = Initial Station of the interval. 

PerimeterIST = Perimeter of the initial cross-section of the interval. 

PerimeterFST = Perimeter of the final cross-section of the interval. 

 

 Volumes Report 

 If the volumes report is selected, the following dialog is displayed. 

 

 

Station: Shows the station where points have been taken. 

 

Overex. Area: Excess excavation area at station indicated. 

 

Underexc. Area: Area to be excavated at station indicated. 

 

Exc. Area: Excavated area at station indicated. 

 

Overex.Vol: Existing excess excavation volume between the previous and next 

station on the list. It is calculated by the Average Areas Method: 

V = ( ( FSt – ISt ) / 2 ) * ( SurFSt + SurISt ) 

where 
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 FSt = Final station of interval. 

 ISt = Initial station of interval. 

SurFSt = Excess excavation surface or surface to be excavated calculated at the 

final station of interval. 

SurISt = Excess excavation surface or surface to be excavated calculated at the 

initial station of interval. 

 

Underexc.Vol. Existing volume to be excavated between the previous and next 

station on the list. Calculated using the same method as for overexcavation volume. 

 

Exc.Vol.: Existing excavated volume between the previous and next station on the 

list. Calculated using the same method as for overexcavation volume. 

 

Total Overexcavation Volume: Sum of over excavation volumes between the initial 

and final stations on the list. 

 

Total Underexcavation Volume: Sum of volumes to be excavated between the 

initial and final stations on the list. 

 

Total Excavation Volume: Sum of excavated volumes on the list. 

 

Print: Allows the list’s contents to be transferred to paper, a Word document, an 

Excel document, etc. (See Lists section). 

 Cross-Sections Report 

This command shows the cross-sections list of the current file.  

It allows the list’s contents to be transferred to paper, a Word document, an Excel 

document, etc.  
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For each point, station, offset regarding horizontal alignment, height and point 

number is showed. 

 Offsets Report 

 If the tunnel cross-sections are circular, the offset at each station can be calculated 

by calculating the geometric center of each cross-section and measuring its adjustment. 

 Currently, this option must not be used unless use the cross-sections are circular. 

 When this command is selected, the following window is displayed, where the 

cross-sections and the station range can be selected 

 

Initial Station:  Initial station for calculating the offset. The minimum station of the 

cross-sections is displayed by default. 

 

Final Station:  Final station for calculating the offset. The maximum station of the 

cross-sections is displayed by default. 
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When the OK button is pressed, the application calculates the tunnel offset as 

follows. 

 It creates groups of points formed by three points 

 For each group it calculates the middle of the circle (which is why the cross-

sections must always represent a circumference) 

 It accumulates horizontal and vertical offset from the middle of the circle with 

respect to the middle of the cross-section. 

 It averages the offsets with the number of groups created. 

 

The data calculated are displayed in the following report. 

 

Station: Station of the cross-section used for calculating the offset.     

Horizontal: Horizontal offset of the cross-sections with respect to the ground plan 

alignment.   

Vertical: Vertical offset of the cross-sections with respect to the elevation alignment. 

X, Y, Z Coord.: 3D coordinates of the offset alignment at the station in question.   

 

For a graphic representation of the calculations, select Draw, which will display the 

following dialog for configuring the input/output format. The options are the same as 

for drawing cross-sections. 
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 The cross-section is light blue, and the theoretical cross-section is green.  The 

place where the theoretical cross-section with the data of the offset applied would be 

placed is shown in red. 

 

 Points Report 

Shows a report containing information about the points in the file contained in the 

project selected. 
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The following data are displayed for each point: 

Number: Number of the point. 

X, Y, Z Coordinates.: Point coordinates. 

Station: Station of the point with respect to the project's alignment. 

Offset.: Distance regarding to the project's horizontal alignment. 

Height Dif.: Height difference with respect to the vertical alignment, which is the Z 

Coordinate – Height of the grade line at the point station 

Difference.: Distance of the point with respect to the theoretical cross-section, a 

negative value indicates that the point is outside the cross-section, or overexcavation 

point.  If no theoretical cross-section has been assigned to the station of this point, 

this field will appear empty. 

Code.: Code of the point that was included in the original file. 

 3D Model 

This group of options allows one to generate a 3D triangulation of the tunnel, take a 

tour inside it and export to several file formats of geometrical definition, are as OBJ 

(Wavefront Technologies) and OFF. 

 

 Draw 

This option does the 3D triangulation and it shows a drawing of this one along with 

the horizontal alignment of the project. 
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For doing this, the program asks for the initial and final stations and the number of 

points that will be created for each profile. 

 

 

 

 Tunnel Traveling 

After 3D model of the tunnel is drawing, the program allows one to take a tour 

inside it. For doing this, the program asks for the following data: 

 

Observer height: Height at which the camera is located, in meters. 

Movement: Forward direction in the tunnel, which can be Direct or Reverse. 

Interval: Increased progress at every step, in meters. 
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 Export 

The program allows one to export the created 3D model to OBJ and OFF formats 

for later viewing in other applications. 

 

 

 Check Tolerances 

This option allows one to check if the measured profiles are under tolerance. The 

program asks for a profile file, initial and final stations and overexcavation and under 

excavation tolerances. 

 



TcpTunnel CAD                                                                                                             Reference Manual 

 

Aplitop S.L. 32 

 

 

 

 After enter the data, clicking on OK button, the program shows the tolerance 

report. 

 

  

 This report shows the profile station, the number of the point and the difference. 

The last column shows, with an asterisk, if the point is under the tolerances entered.   

 

 Clicking on Edit button, the program shows the selected profile graphically. 
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 Compare Cross-Sections 

This command allows to compare two cross-sections files form different stages of a 

project. 

TcpTunnel > Compare Cross-Sections will show up the following dialog. 

 

 

 

In the cross-sections area, select two different files. Shown next to each one will be 

the station range where cross-sections have been defined. 
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The first of the two files selected will be used as a reference point when calculating 

the volumes and surface areas.  Therefore the outer or over excavated surface area 

corresponds to the areas of the second cross-section that are outside the first. 

 

When the compare cross-section dialog OK button is pressed, a list comparing the 

selected cross-section files is displayed.  The first file is used as the reference for the 

outside and inside volumes. 

 

 

 

The program will always close the two cross-sections to make the surface area 

and volume calculations. 

Pressing Draw button allows to draw the comparison of cross-sections. The 

following dialog will be show to set up the drawing options. The Discretization 

distance allows to set the number of points used for drawing the cross-sections. 
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 Export Setting out Marks 

This command allows one to create a grid file for setting out the front using 

TcpTunnel for total station. 

Before running the command, the point grid must be drawn in a separated layer. 

Then, the next steps must be followed: 

- Select a point from the grid. 

- Enter the offset of the point regarding the horizontal alignment. 

- Enter the offset of the point regarding the vertical alignment. 

- Enter the name of the grid file. 

After this, if a tunnel template file exists in the project, the tunnel templates will be 

drawn along with the point grid. 

 General Settings 

This option allows one to change several parameters of the program settings. 
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Station Analysis 

Allows one to activate/desactivate the limits for station analysis. This feature is 

useful for spiral horizontal alignment or horizontal alignments with crossed sections 

which have different heights. The program asks for maximum differences on the left 

and on the right of the horizontal alignment and maximum differences above and below 

of the vertical alignment heights. 

 

For each point, the program will calculate several station solutions along the 

horizontal alignment and then, it will select the first station where the point is under the 

values of the previous four parameters.  

 

This feature is used within the options Calculated Cross Sections and Point 

Report. 

 

Language 

Allows one to change the program language. English or spanish  can be selected. 
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 About 

Shows a window containing the application’s version, sub-version and review 

numbers. 

 

 Reports 

The Print button’s options allow one to transfer the data shown on screen to 

different destinations. 

 

Title of document. 

 

Number Pages: Indicates if one wishes to add page numbers to the Printer option. 

 

First Page: First page of numbering. 

 

Destination: Indicates where one wishes to transfer the information. If one selects 

the Printer option, one can select and configure the printer by clicking on the … 

button appearing in the Printer box on the right-hand side of the screen. Should the 

File option be selected, the information is transferred onto a text file. One can also 

Replace or Add the information should the file already exist. The document can 

additionally be opened once printing is completed (Open Editor). The HTML 
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option creates an HTML document that can be opened with an Internet browser. 

Lastly, the MS Word and MS Excel options create Microsoft Word and Microsoft 

Excel documents. 

 

Do not show this dialog box again unless…: Once the destination where one 

wishes to print the information is configured, the dialog box will not be shown again 

if this box is marked unless the Ctrl key is kept pressed. 

 Horizontal alignment editor 

This application allows one to edit, view and modify ground plan alignments 

(*.EJE).  The editor can work with several files at the same time, and each one will have 

its own window with its own graphic representation. 

 

 File Menu 

 

New:  Opens an empty window for entering a ground plan alignment manually. 

Open:  Opens the file selector to load an existing ground plan alignment. 
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Close:  Closes the active window. If the ground plan alignment it contains has 

been modified, the application will ask before closing the window. 

Save:  Saves the ground plan alignment without asking the name. 

Save As:  Opens the file selector to save the ground plan alignment with a new 

name. 

Import:  Use this menu to import a ground plan alignment in another format.  The 

different formats available are described below. 

Export DXF:  Creates a *.DXF file equal to the graphic representation.  Any 

hidden layer will not be exported. 

Quit:  When one quits the application, it will display a dialog with each window 

that is open, and the ones with changed data will be marked.  If OK is pressed, all 

the marked ground plan alignments will be saved. 

 Manually inserting a ground plan alignment 

To add a ground plan alignment, the data must be entered from left to right. An 

alignment will only be inserted or modified after entering the “Length” field. 

1If an intermediate alignment is modified, one must accept all the different values 

until the “Length” field is reached and write a new value or press “Enter”.  Certain 

fields, such as the coordinates and station, are calculated with these values and therefore 

cannot be modified. 

The following icons are displayed above the numeric data, from left to right are: 

 

Open:  Opens a new ground plan alignment. 

Save As: Saves the ground plan alignment with a new name. 

New: Inserts a new alignment before the cursor position.  The previous alignment 

will be divided in two, respecting the alignment length and the azimuth of the sections.  

The same at pressing the “Insert” key on the keyboard. 

Edit:  The edit button is not available. 

Delete: Deletes the alignment where the cursor is located. 

Search: Opens the search dialog, where one can insert one or several values of each 

field, and the application will look for the nearest alignment. 

Delete All: Deletes the whole alignment. 
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Export: Exports the alignment to a file or printer.  This option cannot be used for 

exporting to other formats. 

 Add a straight 

If one wants to add a straight section, set the parameter and radius fields to zero. 

To change the direction of the straight section, modify the azimuth value. By 

default, the application always marks the exit azimuth of the previous section. 

Sections cannot be created with a length of zero. 

 Add a curve 

To add a curve, set the parameter to zero and write the corresponding radius. 

If the curve radius is greater than zero, the curve will be to the right according to 

the alignment direction, and if it is a negative value, the curve will be to the left. 

The proposed azimuth value is the exit azimuth of the previous section.  The 

application does not allow one to change the azimuth in curved sections. 

 Add a clothoid 

To add a clothoid, a parameter greater than zero must be entered. 

If a radius other than zero is entered, this will indicate an entry clothoid.  A radius 

equal to zero indicates an exit clothoid, which can only come after a curve. 

 Graphic representation 

If one wants to see a graphic representation of the alignment, press the "Graphic 

view" tab.  To configure the dimensioning marks and colours, use the dialog in “Tools-

>Configuration”. 

 Tools 

 Move alignment 

Changes the values to create an alignment parallel to the current one.  A negative 

value will move the alignment to the left, and a positive one to the right. 
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 Adjust Station 

Changes the initial station of the alignment. 

 Invert alignment 

Changes the alignment direction, without changing its length. 

 Configuration 

The graphic representation of the alignment can be changed by modifying the 

elevation parameters and colours to represent each of the marks. 

Allows one to change the colours and distances of the short and long marks, as 

well as the colour of the unique points. 

 

 

Text height: Height of text in metres. 

Short marks interval: Distance in metres between the short marks.  Alongside is 

a button for assigning them a different colour, and the “Options…” button can be used 

to configure the format of the marks. 

Long marks interval: Distance in metres between the short marks.  The mark 

colour and format can also be configured. 

Unique points: Only the colour and format of the unique points can be 

configured.  This mark will appear at the start of each line, curve or clothoid. 

Alignment: To change the colour of the alignment. 

To restore the default values, press the “Restore” button. 
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 Format of the marks and unique points. 

When the “Options…“ button is pressed, the following dialog is displayed, 

where the values of each type of mark selected can be changed. 

 

Mark length: Length of the mark. The line will be perpendicular to the 

alignment. 

Extension length: If one draws texts, this value marks the extension of the mark 

towards the attached text. 

Align texts: the texts can be aligned to the left, the right or not aligned at all. 

 

The options available for the unique points are the same as for the short and long 

marks. One can also indicate if the text is inside or outside. 

 Import ground plan alignment 

Alignments can also be imported from other formats.  Alignments can currently 

be imported in Inland, LandXML and MXRoad format. 

To import an alignment, open the “File->Import” menu and choose the 

appropriate type. 
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 Vertical alignment editor 

This application allows one to edit, view and modify elevation alignments (*.RAS).  

The editor can work with several files at the same time, and each one will have its own 

window with its own graphic representation. 

 

 File Menu 

 

New: Opens an empty window for entering an elevation alignment manually. 

Open: Opens the file selector to load an existing elevation alignment. 

Close: Closes the active window. If the elevation alignment it contains has been 

modified, the application will ask before closing the window. 

Save: Saves the elevation alignment without asking the name. 

Save As: Opens the file selector to save the elevation alignment with a new name. 

Import: Use this menu to import an elevation alignment in another format.  The 

different formats available are described below. 
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Quit: When one quits the application, it will display a dialog with each window 

that is open, and the ones with changed data will be marked.  If OK is pressed, all 

the marked elevation alignments will be saved. 

 Manuel insertion 

To enter an elevation alignment, first enter the “Station” and the “Heights”, and the 

programme will automatically move the cursor in these two columns.  Then one can 

change the data of the agreements.  This is necessary because the data of the previous 

and next line are needed to calculate the agreements of a given line. 

The application will calculate if there is any overlap lapel between the different 

sections, and the cell where the overlap occurs will be shown in red.  if there is overlap 

when a Kv, tangent or arrow is entered, the supplementary values will not be calculated. 

To add more data, go to the last row and press “Cursor down”, and a new line for 

adding more data will appear.  If one leaves the new line without changing anything, it 

will be deleted automatically. 

The following icons are displayed above the numeric data, from left to right are: 

 

Open: Opens a new elevation alignment. 

Save As: Saves the elevation alignment with a new name. 

New: Inserts a new alignment before the cursor position.  The previous alignment 

will be divided in two, respecting the agreements.  The same as pressing “Insert”. 

Edit: The edit button is not available. 

Delete: Deletes the alignment where the cursor is located. 

Search: Opens the search dialog, where one can insert one or several values of each 

field, and the application will look for the nearest alignment. 

Delete All: Deletes the whole alignment. 

Export: Exports the alignment to a file or printer.  This option cannot be used for 

exporting to other formats. 
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 Graphic representation 

If one wants to see a graphic representation of the elevation alignment, press the 

"Graphic view" tab.  To configure the dimensioning marks and colours, use the dialog in 

“Tools->Configuration”. 

 Tools 

 Move height 

Modifies the height of the elevation alignment respecting the agreements.  A 

negative value will move the elevation alignment down, and a positive one up. 

When the height of an elevation alignment is moved, the agreements do not 

change. 

 Adjust Station 

Changes the initial station of the elevation alignment, without modifying the 

agreements. 

 Configuration 

Accessed from “Tools->Configuration”. 

 

The following layers appear in the representation: 

Short marks: Draws a vertical line from the minimum height to the grade line 

height.  The distance between these marks is configurable. 
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Long marks: Draws a vertical line from the minimum height to the grade line 

height.  The distance between these marks is configurable. 

Unique points: Colour of the unique points.  Draws a vertical line at the following 

points: 

 Station - tangent 

 Station + tangent 

 Station if the tangent equals zero. 

Guitar: Colour of the separation lines and legend. 

Grade line: Colour of the graphic representation of the grade line. 

Previous grade line: Colour of the polyline formed by the station of each unique 

point and its height. 

 Import elevation alignment 

Elevation alignments can also be imported from other formats.  The formats 

accepted at present are Inland, LandXML and MXRoad. 

To import an elevation alignment, open the “File->Import” menu and choose the 

appropriate type. 
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 Superelevations editor 

This application allows one to edit, view and modify superelevations (*.PER).  The 

editor can work with several files at the same time, and each one will have its own 

window with its own graphic representation. 

 

 File Menu 

 

New: Opens an empty window for entering superelevations manually. 

Open: Opens the file selector to load a superelevation file. 

Close: Closes the active window. If the superelevations it contains have been 

modified, the application will ask before closing the window. 

Save: Saves the superelevations without asking the name. 

Save As: Opens the file selector to save the superelevation with a new name. 
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Exit: When one quits the application, it will display a dialog with each window 

that is open, and the ones with changed data will be marked.  If OK is pressed, all 

the marked superelevations will be saved. 

 Manuel insertion 

To add a ground plan alignment, the data must be entered from left to right. An 

alignment will only be inserted or modified after entering the “Length” field. 

The superelevations must be entered with ascending station values. 

The following icons are displayed above the numeric data, from left to right are: 

 

Open: Opens a new superelevation file. 

Save As: Saves the superelevations with a new name. 

New: Opens a dialog to insert a new superelevation.  El nuevo peralte se insertará en 

orden según su valor de P.K. 

Edit: Opens a dialog for editing the current superelevation. If the station is 

modified, the superelevation will be moved so that the stations are in ascending order. 

Delete: Deletes the alignment where the cursor is located. 

Find: Opens the search dialog, where one can insert one or several values of each 

field, and the application will look for the nearest alignment. 

Delete All: Deletes all the superelevations. 

Export: Exports the superelevations to a file or printer.  This option cannot be used 

for exporting to other formats. 

Pressing “Insert” will insertar a new superelevation with a station that will be the 

Midpoint between the previous and current alignment. The left and right superelevations 

will be interpolated to maintain the same slope. 

To add more data, go to the last row and press “Cursor down”, and a new line 

for adding more data will appear.  If one leaves the new line without changing anything, 

it will be deleted automatically. 
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 Edit superelevation 

When the “New” or “Edit” button is pressed, the application displays the 

following dialog, where the values of the station, left superelevation and right 

superelevation can be modified or entered.   

 

If the “Pumping” box is checked, a superelevation with the values -2.0, 2.0 will 

be created 

When the dialog is okeyed, the new superelevation will be inserted or will move 

(if it is being edited), to the row for which the stations are in ascending order. 

 Graphic representation 

If one wants to see a graphic representation of the superelevations, press the 

"Graphic view" tab.  To configure the dimensioning marks and colours, use the dialog in 

“Tools->Configuration”. 

 Tools 

 Adjust Station 

Changes the initial station of the superelevations, without changing the left or 

right-hand values. 

 Configuration 

The graphic representation of the superelevations can be changed. 

Accessed from “Tools->Configuration...”. 
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Left superelevation: Colour of the left superelevations. 

Right superelevation: Colour of the right superelevations. 

Superelevation text: Colour of the texts that appear on the superelevations. 

These appear in each unique item. 

Elevation line: Colour of the vertical lines in each unique point, and of the 

horizontal line that separates the positive and negative superelevations. 

Text height: Height of the text drawn on the superelevations. 

To restore the default values, press the “Restore” button. 

 

 Cross-section editor 

This application allows one to edit, view and modify cross-sections.   
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The window is divided into two parts, with the left side showing information 

about the files open, and the cross-section data.  The right-hand side is the graphic 

representation of the cross-section. 

The editor lets one have several files open at the same time, and for a specific 

station will show all the cross-sections that have been defined at that station. 

At the bottom of the window is a status bar, the left-hand side of which displays 

the cursor coordinates.  The right-hand side displays the current status information 

(modifying a figure, erasing vertices), and always shows information about the 

graphical edition of the cross-section. 

 Cross-sections panel 

On left-hand side of the window is a panel that shows the station, file, vertices and 

files loaded. 

There follows a description of the different parts of the panel from top to bottom: 

 Current station 

The station that is being viewed can be changed by entering a value or by using 

the scroll bar.  If a value is entered, the nearest station will be displayed. 

If there are several files, scroll through the list of all the stations of the cross-

sections. 

Next to these controls and from left to right are buttons for changing station: 

First: Move to the initial station of all the loaded cross-sections. 

Prev: Move to the previous station. 

Next: Move from the next station to the current one. 

Last: Move to the final station of all the loaded cross-sections. 

 Current file 

A dropdown window indicates the current file if more than one file has been 

loaded.  This appears with the full route. 

If cross-sections exist in more than one file for a given station, the data can be 

changed by changing this control 
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 Cross-section vertices 

The vertices of the current cross-section are shown in a table where they can be 

modified numerically. 

If there is no cross-section in the selected file for the current station, this panel 

will be disabled, and the values cannot be changed. 

If the cross-section is changed graphically by moving or deleting trhe vertices, 

this table will be updated automatically. 

When a specific row is selected, the graphic representation will display the vertex 

that corresponds to that marked row. 

 Cross-sections in memory 

This table shows the cross-sections loaded in the memory  It is also possible to 

change how they are shown in the graphic window, and to change their color. 

 Graphic representation panel 

In the right-hand side of the main window is a graphic representation of the cross-

sections defined in the current station. 

Vertices can be moved, deleted or inserted in this window by using the toolbars. 

 Tools 

The following options can be used to modify the cross-sections in the selected 

file. 

 Move alignment 

Move the cross-section horizontally. A negative value moves it to the left, and a 

positive one to the right. 

One can choose whether to apply it to the current cross-section or to all the 

cross-sections in the file. 

Accessed from “Tools->Move alignment…” 

 Move height 

Move the cross-section vertically. A negative value moves it down and a positive 

one moves it up. 
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One can choose whether to apply it to the current cross-section or to all the 

cross-sections in the file. 

Accessed from “Tools->Move Height…” 

 Invert all 

Inverts the direction of all the cross-sections of the selected file. 

Accessed from“Tools->Invert all…” 

The cross-sections generated by MDT and TcpTunnel generate the vertices to the 

right or clockwise, and the Invert commands can be used to change the direction and be 

able to use them in applications where the points have to be facing the opposite 

direction. 

 

 Graphic tools 

All the editors appear have toolbars for accessing a series of commands, and 

depending on the type of editor, some commands might not be available.  However, 

they work in the same way in all the editors. 

 Standard 

This toolbar contains the options used most frequently to move about the 

drawing, and zoom an area in particular. 

 

The buttons from left to right are: 

Zoom in: Zoom the view of the drawing from the middle of the drawing.  One 

can also use the mouse wheel by moving it forward, but in this case the origin will be 

the position of the mouse. 

Zoom out: Zoom the view of the drawing from the middle of the drawing.  One 

can also use the mouse wheel by moving it backwards, but in this case the origin will be 

the position of the mouse. 

Zoom Extension: The view is enlarged or reduced so as to see all the items in 

the drawing, only taking into account the visible layers 
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Zoom Window: To zoom in one an area of the drawing, the first click of the 

mouse marks a corner of the window, and the second marks the opposite corner. 

Adjustment: The drawing can be moved by clicking on the window and moving 

the mouse without letting go of the window. 

 Layers 

This tool bar allows one to display or hide the different layers of the drawing. 

When one presses on the pulldown control, a list of all the layers is displayed.  

Each row contains the following fields. 

 Visible layer, indicated by a lightbulb. If the layer is greyed out, it is not visible. 

 Default colour of the layer 

 Name of the layer. 

 

 Grid 

Includes buttons for enabling or disabling the references on the drawing 

currently being viewed. They will only be enabled when it is a 2D drawing. 

 

The buttons from left to right are: 

Alignments:  Draws the XY axes on the drawing. 

Horizontal Lines: Plots horizontal lines on the drawing to show its Y 

coordinates. 

Vertical Lines: Plots vertical lines on the drawing to show its X coordinates. 

Grid: Enables or disables the display of the points grid on screen to provide a 

visual reference. 

Adjust to grid: Restricts the cursor coordinates to specific coordinates. 

Grid properties: Displays a dialog for changing some of the grid values, such as 

the size and colours. 

  Grid configuration 

 The colour of the grid, lines and drawing support texts can be changed. 
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This dialog pops up when the Configure Grid button is pushed. Although this 

button appears in the main window and the editors, the configuration values are the 

same in all of them. 

 

Horizontal Grid: Distance between the grid points on the X axis 

Vertical Grid: Distance between the grid points on the Y  axis. 

The colour of the text and the points can also be changed by pressing the 

appropriate squares. 

Adjust to horizontal: Values to which the X coordinate of the cursor will be 

adjusted. 

Adjust to vertical: Values to which the Y coordinate of the cursor will be 

adjusted. 

These last two values will only be applied if the “Adjust to grid” option is enabled. 

  Guitar configuration 
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Text height: Allows one to change the size of the text displayed next to the 

vertical and horizontal support lines 

Keep text on screen: The text that accompanies each line is displayed at the 

bottom or to the left of the line. Mark this option if the text is not visible but it must be 

displayed on the edge of the screen. 

The colour of the lines and text can be changed independently for each type of 

line, using the appropriate boxes. 

 References to figures 

References to objects allow one to quickly select exact geometrical points in 

existing figures, without having to know the exact coordinates of those points.  

References to objects can be used to select the end point of a line or arc, the midpoint of 

a circle, or any other geometrically significant position. 

When more than one reference is activated, the closest of all the activated ones 

will be displayed. 

 

The buttons from left to right are: 

Point: Marks the point closest to the cursor position.  Only applies to point-type 

figures. 

Close: Marks the point closest to the cursor position, applicable to any figure. 

End point: Marks the edge of the figure, or of one of its parts that is closest to 

the mouse position.  Does not apply to circles. 

Midpoint: Mark the midpoint of the figure. 
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Centre: Mark the centre of the arc or circumference closest to the mouse. 

 

 Helps 

 

The buttons from left to right are: 

Measure: This command allows one to measure distances between two points, 

by first selecting the initial point of the measurement, and then the final point.  The 

distance measured will be displayed in the status bar.  It is advisable to activate the most 

necessary references to figures, or else the application may return incorrect data if it 

does not use the coordinates of the point one believes is selected. 

After the second point is selected, the next window appears. 

 

The values of the initial and final point in row XY, XYZ represent the distance 

from the origin to the point on the XY or XYZ plane respectively. 

Number Edit: Displays the following window, where the coordinates can be 

entered manually.  If it is a 2D drawing, the Z coordinate control will be disabled. 

 

After entering the coordinates, press OK. In absolute coordinates mode, the 

entered coordinates will be added. In relative coordinates mode, the entered coordinates  

will be considered increments since the last point entered. 



TcpTunnel CAD                                                                                                             Reference Manual 

 

Aplitop S.L. 58 

 

 Modify 

Commands for modifying the polylines that form a cross-section. 

 

The buttons from left to right are: 

Insert vertex: Insert a vertex at the selected point.  It must be near an edge. 

Delete vertex: Eliminates the selected vertex. It is advisable to have selected the 

polyline to see where the vertices are. 

Delete vertex range: Mark two vertices and all the vertices between them will be 

deleted. 

Delete vertex window: Mark a checkbox with the mouse and the vertices inside 

it will be deleted. 

Exchange vertices: It exchanges the order of the two selected vertices for 

creating the polyline which join them. 

Join poylines: It joins the selected polylines. 

 Move 

Commands for moving figures. 

 

From left to right, these are as follows. 

Move figure: First select the figure to move, then select a point as the origin, 

and lastly select a point as the destination. The figure will be moved by the vector 

formed by destination – origin. 

Move figure to the origin: First select a figure, then assign a point of origin. The 

figure will be moved by the vector coordinate origin. 

Move figure to the clipboard: This command functions like the previous one 

(Move figure to the origin), but the figure will be copied to the clipboard. Then go to 

the layer that is to be modified and paste in the figure using Ctrl+V. 

The best way to assign the origin or destination coordinates is to use the references to 

figures, or enter the coordinates manually, using the coordinates command. 

 


